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LETTER FROM THE PRESIDENT
Friends and New Customers:

We are pleased to bring you Final Effects AP, the newest member of our award-winning,
industry-leading family of MetaTools products. Many of you have unleashed the creative
and productive capabilities of previous MetaTools products and appreciate what these tools
can do for your creative process. We believe you will be equally as pleased with the imple-
mentation of these new  time-based tools. New entrants to the creative world of the
MetaTools product family will find nothing short of the most powerful set of video special
effects plug-ins for Adobe Premiere.

Final Effects AP’s 16 plug-ins help you transform basic video compositions into spectacular
professional-level presentations for output on video, film or CD-ROM. For example, Final
Effects AP’s sophisticated particle systems should delight even the most seasoned profes-
sional with unique custom controls that provide precise and flexible image composition
capabilities. These particle systems offer the ability to generate fire, smoke, rain, snow,
explosions, and more, with dynamic realism and finesse. Final Effects AP plug-ins offer an
almost infinite number of combinations, with complete and interactive control over even
subtle compositing details.

Videotape, CD-ROM, game development, training, interactive tutorials, and kiosks- no 
matter what kind of animation you want to produce, Final Effects AP is the indispensible
tool that immediately enhances your ability to produce stunning visuals with professional
quality and flexibility. With Final Effects AP and your favorite video editing package, any digi-
tal video Effects Master can create visual effects on the desktop which were formerly possi-
ble only on workstation-level video editing systems often costing hundreds of thousands of
dollars.
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With Final Effects AP we intended to bring this incredible technology to a much wider audi-
ence. In creating these tools as plug-ins for Premiere, we hope that many more people will
be able to quickly and comfortably achieve a new level of performance in their video pro-
duction. Our beta sites have provided us with excellent support, feedback, and constructive
criticism as Final Effects AP has moved from the lab into its commercial form. The over-
whelmingly positive response we have received is a testament to the depth and breadth
of this professional-level solution.

You now have an incredible set of image manipulation and creation techniques never
before available. There are also ways of producing complex images which only the most
dedicated designer (with dozens, or in some cases, hundreds of free hours) could have
created with existing tools. You will find Final Effects AP to be a serious production tool that
provides you with new degrees of creative freedom.

Our team at MetaTools continues to explore new ways of expanding your desktop video
production and multimedia horizons. We trust that you will find the journey exciting and
fruitful. We look forward to your constructive criticism and suggestions for on-going devel-
opment. Thank you for your continued encouragement and support.

Sincerely,

John Wilczak
Founder and CEO
MetaTools
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Getting Started

Everything you need to know about this Explorer’s
Guide, system requirements, installation, and
technical support.
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ABOUT THIS EXPLORER’S GUIDE
We’ve divided this Explorer’s Guide into five main sections: Getting Started, Whirlwind Tour,
Learning the Interface, Plug-in Descriptions, and In Closing.

The first section, Getting Started, includes manual information, installation instructions,
information on technical support, etc.

The second section, Whirlwind Tour, contains a guided tour tutorial to familiarize you with
the product, and its basic features.

The third section, Learning the Interface, provides detailed descriptions of the Final Effects
AP User Interface.  

The fourth section contains a detailed description of each effect’s basic control parameters,
in alphabetical order by filter name, with the four transitions grouped at the end.

The fifth and final section, In Closing, contains the Glossary and Index, along with our
Acknowledgements and the Software License Agreement.

Terms and Conventions

If you are familiar with standard PC operations, most of the terms used in this Explorer’s
Guide will already be familiar to you.

In this guide, we make a distinction between clicking the mouse button (which is a quick
press and release) and pressing the mouse button (pressing and holding the mouse but-
ton down). We use the term “press and drag” versus the more common, but (we believe)
less accurate “click and drag.”
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BEFORE YOU BEGIN
Since Final Effects AP is a set of plug-ins which adds functionality to Adobe Premiere, you
should be reasonably familiar with Premiere before you begin to use Final Effects AP.  If
you are new to Premiere, we strongly suggest that you work with Premiere until you feel
comfortable with it, and then dive into Final Effects AP.

Minimum System Requirements

Windows PC: 486-DX2-66 MHz or greater;  8-bit video; Windows 95 or Windows NT;
Premiere 4.2 or newer; applications that 100% support the Premiere plug-ins standard.

Recommended: Pentium; 32 MB RAM; 24-bit video.

Installation

The Final Effects AP CD-ROM contains an installation program to allow you to quickly and
easily install Final Effects AP into your Adobe Premiere software.  To begin the installation
process, simply double-click on the installation icon and follow the on-screen instructions.
For a detailed discussion of the installation process, refer to the Read Me file, included on
the Final Effects AP CD-ROM.

Technical Support

If you are a registered user of Final Effects AP and would like technical assistance, the best
way to reach us is via America Online.  If you are not on America Online, we can also be
reached via the Internet or by phone.
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On America Online, we can be reached by using the keyword KPT to go to our online
forum, or you may send e-mail directly to KPT Support for technical assistance and general
questions.  Response time is generally within 24 hours.

If you are not on America Online, you can send us e-mail via any Internet gateway. Our
Internet address is KPTSupport@aol.com.

If you have access to the Web, check out our website at http://www.metatools.com.

Registered users may also contact our Technical Support Department, Monday through
Friday, 9:00 a.m. to 5:00 p.m. Pacific Standard Time, at (805) 566-6200.

Talk to Us Online

We invite you to get online and join the rapidly growing community of graphics profession-
als and enthusiasts who share knowledge and ideas in our weekly America Online live
chat, often hosted by Kai himself.  Currently we meet Tuesday nights at 7:30 p.m. PST.
Use keyword KPT to enter our forum, then click on the MetaTools Chat button to enter the
fray!
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WHIRLWIND TOUR
This whirlwind tour consists of a series of mini-tutorials designed to get you on your way
enhancing your video clips. You’ll learn how to load a clip, apply an effect to it, and ani-
mate the effect by changing parameters (attributes) at various times throughout the ani-
mation (keyframing), adding a second clip and how to transition between the two. 

Tutorial: Adding FE Effects

1. Open Adobe Premiere.  Load the file by selecting File>Open and choosing the file
“Tour” in the Projects directory of the Final Effects AP CD. If the Construction window
is not open, select Window>Construction (or press Ctrl+5) to open it.

2. Select the first clip in the Construction window. You should see the MetaTools logo.

3. Open the Filters window by selecting Clip>Filters or by pressing Ctrl-F. The Filters
Selection dialog box opens.

You can also right-click on a clip in the Construction window, to get the Filters
Selection dialog box.

4. Scroll down and select the FE Pixel Polly effect by double-clicking on it in the Available
menu. The Pixel Polly Final Effects interface appears. 

5. Locate the VCR control buttons in the lower center of the interface, then click the Play
button to preview the Pixel Polly effect. Pretty cool, huh? Now click the Red Stop but-
ton but don’t click OK just yet.

6. Now you’ll add a pause before you apply the effect. If you don’t, the shatter will occur
in the first frame of the clip and you’ll only see the effect for a split second.
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You’ll use keyframes to set a pause.

7. Set the Time slider, located at the bottom of the interface, to 0. It should be at 0 by
default, but just in case you’ve moved it, check that it’s at 0 now. 

To change parameters at various times in your animation, simply advance the Time
slider to the desired time then adjust the parameters. A keyframe is automatically set
specifying that the selected parameter has the specified value at that time in the ani-
mation. A grey diamond to the left of the parameter indicates that there are
keyframes for that parameter. A black diamond indicates that there is a keyframe for
that parameter at the current frame.

To adjust a parameter, either press and drag to adjust the slider for that parameter or
Ctrl-click on the slider bar to enter a numeric value. If you drag the slider, the numeric
value appears to the right of the VCR controls. The minimum and maximum values
for each parameter appear in the numeric entry window.

8. For the first keyframe (at time = 0), set the Explosion Speed, Gravity, and Rotation
Speed all to 0. Make sure Direction Randomness is 20 and Speed Randomness is 75.
These are the starting values for these parameters. The first keyframe is automatically
set.  (See Figure 1.)

9. Now advance the Timer slider to 100. Normally keyframes are set automatically.
However, if you want to maintain the same parameter setting for consecutive
keyframes, you must manually enter a keyframe. This is useful for creating a pause or
stalling a parameter change.

To manually enter a keyframe, press the right mouse button on the Explosion Speed
slider, and scroll down to select Add Key. A keyframe is now set at time = 100, for
Explosion Speed = 0. Notice the black diamond to the left of the Explosion Speed
slider indicating a keyframe exists for this attribute, at this frame.
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10. Repeat step 9, setting keyframes to maintain the settings for Gravity and Rotation
Speed.

11. Advance the Time slider to the far right, to 301, then set the Explosion Speed slider to
25. This keyframe for Explosion Speed is automatically set. Again, notice the black dia-
mond indicating that the current frame is a keyframe for this parameter.

13. Set the Gravity to 25 and the Rotation Speed to 30.

14. Click the Play button, sit back, and enjoy the preview. When the show’s over, click the
Stop button. Click OK to exit the Pixel Polly interface. Then click OK to exit the Filters
window and return to the Construction window.

Tutorial: Transitions

Now you’ll see how easy it is to transition between clips using Final Effects AP transitions.
A transition is an effect used to gradually move between two clips. Here you’ll transition
between the shattering logo and Bill’s bad hair day. Then you’ll add some more effects.

1. Open the Transitions window by selecting Windows>Transitions (Ctrl+6). In the
Transitions window, scroll till you find FE Page Turn. Press and drag to move it to the
Transitions track in the Construction window. Be sure to place it between the last
frame of the MetaTools logo clip in Video Track A and the first frame of the Billy Boy
clip in Video Track B. (See Figure 2a. & b.)  Now you can transition between the two
clips. Simple, eh?

2. Now you’ll try to get some help for Bill’s hair by adding an effect. Left-click on the first
half of the Billy Boy clip to select it. 
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Figure 2a. The Transitions Window

Figure 2b. Placing a transition



When you select this clip, you’ll notice a moving dotted outline surrounds only part of
the clip. This clip has been cut into two pieces so that you can apply two effects inde-
pendently of each other. If the clip had not been cut, the two effects would interact.

3. Select Clip>Filters (Ctrl-F) and double-click on FE Rain.

4. Make sure the Time slider is set to 0, then drag the Opacity slider all the way to the
left (0 opacity is transparent). 

5. Advance the Time slider to 300. Manually add a keyframe for Opacity by right-clicking
on the Opacity slider, and selecting Add Key. This holds the Opacity at 0 from frames
0 to 300.

6. Advance the Time slider to 375 and set the Opacity to 40. This automatically sets a
keyframe. (See Figure 3.)

7. Advance the Time slider all the way to the right and set the Opacity to 5.

8. Preview the effect by clicking the Play button. Click the Stop button to stop the pre-
view, then click OK to exit the window. Click OK again to exit the Filters window and
return to the Construction window.

9. Now you’ll add an effect to the second part of the Billy Boy clip. Left-click on the last
frame of the clip. Then select Clip>Filters (Ctrl-F), and double click to select FE
Bubbles. The FE Bubbles interface appears.

10. In the FE Bubbles interface, set the Time slider to 0, left-click the Composite Bubbles
box to select it. This tells FInal Effects to composite this effect on the clip rather than
on the default black background. Set the Reflection Type to Inverse Reflection,
Shading Type to Fade Inwards, and Bubble Amount to 0. (See Figure 4.)

11. Advance the Time slider all the way to the right and change the Bubble Amount to
70. 
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Figure 3. FE Rain

Figure 4. FE Bubbles



12. Click the Play button to preview. Click the Stop button then click OK to exit the effects
interface. Click OK again to exit the Filters window and return to the Construction win-
dow.

Tutorial: FE Particle Systems II

One of the most comprehensive effects in Final Effects AP is the FE Particle Systems II
effect. Here’s a little taste of what you can do with it.

1. Select Windows>Transitions, and scroll to FE Radial Scalewipe. Press and drag Radial
Scalewipe, placing it in the Transitions track, between the end of the Billy Boy clip and
the beginning of the Flag clip. Now you’re ready to add some sparks. In the
Construction window, left-click to select the flag clip at the end of Video Track A.

2. In the Construction window, left-click to select the flag clip at the end of Video Track A.

3. You’ll create the fireworks in two parts using the FE Particles Systems II effect. First
you’ll create the “burst” part of the fireworks. Select Clip>Filters, then double-click on
the FE Particles Systems II.

4. Set the Time slider to 0, then set the X-Radius Producer to 35 and the Y-Radius
Producer to 27.  Change Particle Animation Type to Viscous Explosive. Then change
the attributes as follows:  

Birth size to 40
Death size to 50
Max Opacity to 0
Direction to 169
Velocity 9
Birth Rate 70
Longevity 55 (See Figure 5.)
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Figure 5. FE Particle Systems II



Gravity 8
Turbulence 15

5. To place the effect in relation to the flag image, click the Composite Particles box. The
flag appears in the preview window. Move the cursor to the preview window and
notice the cursor changes to a multidirectional arrow. This is used for placing an effect.
For example, if an effect were to radiate outward, it would do so from the center
point. 

6. Left-click in the Preview window, at the top right corner of the flag to set the center of
the effect.

7. Because you want the fireworks to explode behind the flag, you must now turn off
Composite Particles and remove the keyframe that turned it on. This was just used as
a visual aid in placing the effect.

Left-click in the Composite Particles checkbox to turn it off.  If you accidentally set a
keyframe, right-click and drag in the Composite Particles Box to select Delete Key.

8. Advance the Time slider to 100.  Change the X-Radius Producer to 12, the Y-Radius
Producer to 10, and the Max. Opacity to 35. (See Figure 6.)

9. Advance the Time slider all the way to the right to 210.  Change the X-Radius
Producer to 50 and the Y-Radius Producer to 40.  Change the Max. Opacity to 100.

10. Click the Play button to watch the fireworks explosion.  Press Enter twice to return to
the Construction Window.

11. Now you’ll launch the fireworks.  In the Filters menu, select FE Particle Systems II.
There are now two FE Particle Systems II in the Current Filter menu.

12. Set the Time slider to 0, then set the Particle Animation Type to Direction and the
Particle Object to Pixel. Click on Composite Particles. (See Figure 7.)
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Figure 6. Expanding the Fireworks Explosion

Figure 7. The Fireworks Starting Point



13. Move the cursor to the Preview window and notice it changes to a multi-directional
arrow cursor. Set the center point in the lower right corner. 

14. Move the Time slider to 70.  (See Figure 8.)

15. Move the cursor to the Preview window and click in the center of the explosion.

16. Change the Longevity to 6 and the Max. Opacity to 20. 

17. Move the Time slider to 75 and change the Max. Opacity to 0 to finish the effect.
(See Figure 9)

18. Click on the Play button to watch the fireworks be shot in the air, then explode.  Click
OK to exit the Particles Systems interface, then click OK again to exit the Filters win-
dow.

It’s Showtime…  

1.    Go to Make>Movie to view your new movie.  Make sure that the yellow Preview Bar
(in the Construction window) runs the length of the clip and that you are saving to
your hard disk.  If your system contains a small amount of RAM or uses a slower
processor, try changing the output Options size to 160h, 120v and lower the com-
pression quality.

Credit Roll

Flag clip courtesy of MetaTools Power Photos collection.

Bill’s Bad Hair Day courtesy of MetaTools Kai’s Power Goo, liquid imaging software.

(Call MetaTools for product and sales information.)
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Figure 8. The Fireworks Ending Point

Figure 9. The Fireworks Finale
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Learning the Interface

All of the plug-ins in Final Effects AP use a similar
interface with several common elements.
Understanding these common interface elements
makes it easier to use each plug-in.
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Plug-In Title

Starting, Current, and
Ending Frames

Clear Current Keyframe
and Clear All Keyframes

Stop and Play
Animation

Previous and Next
Keyframes Cancel and OK buttons

Timeline

Pop-up Menu

Control Dial

Control Slider

Preview Panel

Interpolation Type



COMMON ELEMENTS
Plug-In Title

The name of the current plug-in appears at the top of each plug-in dialog box (directly
underneath the window title bar).

Preview Window

The Preview window is located in the upper left corner.  The Preview window shows you a
small sample of what your source image looks like with the current plug-in settings
applied.

Center Control

To set the center point for your effect (except Flo Motion), simply click at the desired loca-
tion in the Preview window.  By changing the center point at different places along the
timeline, you can move the position of your effect over the course of the animation.

Control Dials

When appropriate, an effect dialog box contains one or more control dials to set such
parameters as Rotation or Twist.  While some of these controls (such as Rotation) are sim-
ple direction specifiers, others (such as Twist) let you specify both direction and intensity,
and can often be “spun” several times to create very intense settings.
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Control Sliders

A standard control element, control sliders are used to specify linear effect parameters
such as the number, size, or speed of particles in an explosion.

Numeric Entry

To adjust values of any parameter by numeric entry, control-click on the parameter slider or
the Control Dial. A numeric entry panel will appear and you can enter a value in that win-
dow.

Timeline Controls

Stop Button

The stop button stops playback of your preview. 

Play Button

The single arrow button (in the bottom left of the dialog box) is the Play button. Clicking it
starts your animation playing in the Preview window. You can also begin playback of your
preview by pressing the spacebar.

Previous and Next Keyframe

The left and right arrow buttons to the right of the Stop and Play buttons are used to jump
to the previous or next keyframe on the timeline.

24 Final Effects AP Explorer’s Guide

Co
m

m
on

 E
le

m
en

ts



The timeline itself is used to specify where in the course of your video clip you want to set
changes to your effect parameters.  Clicking anywhere within the timeline selects that
frame.  The keyframe controls can then be used to set or clear a keyframe at that point.

Interpolation Type

This button determines how values are interpolated between keyframes. There are three
types of interpolation:

Linear creates straight line interpolations between keyframes with uniform inbetween time
values. Linear interpolations are great for motion that need abrupt changes, such as a rapid
change in direction.

Ease In/Ease Out creates spline interpolations that have starting and ending velocities of 0.
Ease In/Ease Out offers smoother interpolations than Linear interpolation, and is great
when you want the effect to “pause” at each keyframe. 

Bezier creates spline interpolations similar to Ease In /Ease Out interpolations, but does
not smooth out the curve as much at the keyframes. Bezier interpolations offer smoother
motion than Linear and Ease In/Ease Out. 

Remove Keyframe

The single-key-with-a-red-line-through-it button is the Delete Keyframe button. Clicking this
button clears all keyframes for the current frame in the timeline.
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Remove All Keyframes

Next to the Delete Keyframe button is the Delete All Keyframes button. Clicking this clears
all keyframes from the entire timeline, removing any animation from your effect. It also
resets all effect parameters to their default settings.

Cancel and OK Buttons

These two buttons function exactly as you would expect, allowing you to exit the dialog
box and either ignore (Cancel) or apply (OK) your settings.

Animation Elements and Techniques

In addition to standard dialog box elements, all plug-in dialog boxes also contain controls
and sub-windows for changing the animation settings for various plug-in control parame-
ters. 

Animation Diamonds

A diamond to the left of a parameter indicates that there are keyframes for that parameter
(i.e., it is animated). A black diamond means that there is a keyframe for that parameter at
the current frame in the timeline. 

Start/Current/End Frame

Below the timeline, you see the starting and ending frames for the clip at the start and
end of of the timeline. At the midpoint of the timeline the current frame is displayed, and
the diamond next to it indicates if there are any keyframes at the current frame. 
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Keyframe Pop-Up Window

By right-clicking on an attribute, you bring up its Keyframe Pop-Up window. Here you can
add a keyframe for the attribute at the current frame, delete the key for this attribute at the
current frame, and delete all keys in the timeline for this attribute. 

Adding Keys

To add a key for an attribute, right-click on the attribute, and select “Add Key.” A keyframe is
added at the current frame. After you have added the first keyframe in this manner, you
can add new keyframes by simply moving the attributes knob/slider/etc. A new keyframe
is automatically added at the current frame.

Deleting a keyframe

To delete a keyframe for an attribute, select the frame in the timeline that has the
keyframe you want to delete, right-click on the attribute slider, and select “Delete Key.” This
deletes the keyframe for this attribute at the selected (current) frame. 

Deleting all keyframes

To delete all keyframes for an attribute, right-click on the attribute and select “Delete All
Keys.” This removes all animation for that attribute only, but not for any other attribute.
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Plug-In Descriptions

This section describes each of the Final Effects AP
plug-in filters.  Following the filter descriptions is a
brief discussion of the four Final Effects AP 
transitions.
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FE BALL ACTION
The Ball Action plug-in creates the effect of your image turning into balls which can rotate
or twist around specified axes.

Scatter

Scatter allows the balls to break free of the 2D plane they are located on, scattering them
into 3D space. The Scatter slider lets you control the overall intensity of the scattering
effect. Dragging to the right increases scattering, sending the balls further and wider apart.
Dragging to the left decreases the scattering, keeping the balls fairly close together.

Number of Balls

Use this slider to set the total number of balls created by this effect.  Dragging to the right
increases the number, while dragging to the left decreases it.

Rotation

Click or press and drag within the Rotation control dial to set the distance the balls will
revolve around the specified axis (or axes, as the case may be).

Axis

Press on the Axis pop-up menu, then drag down to select the axis/axes the balls will
revolve around. You can select from the following options.
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Single Axis (X, Y, or Z)

The balls rotate around whichever axis you select. The X axis is horizontal, the Y axis is ver-
tical, and the Z axis is depth (foreground to background). Use this to give the balls a tum-
bling effect.

Dual Axis (XY, XZ, or YZ)

Use this feature to select a combination of two different axes around which the balls
rotate in unison. The Rotation selected with the Rotation control dial affects both axes.

XYZ Axis

Use this feature to make the balls rotate around all three axes in unison. This creates the
illusion of out-of-control motion.

X15Z Axis

The balls rotate 15 times around the Z axis for every one rotation around the X axis. The
effect is a whirl, something like a rotating galaxy of particle spheres. The settings for this
effect are very sensitive.

XY15Z Axis

The balls rotate 15 times around the Z axis for every rotation around both the X and Y axis.
The settings for this effect are also very sensitive.
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The original image (top), and after use of the FE Ball
Action plug-in.



Twist

Use this control dial to set the intensity of the twisting of the balls.  You can control the
type of twisting with the Property attribute (see below).  To get more intense twisting, set
the Twist control dial past 360° from your starting point.

(Twist) Property

Press on the Property pop-up menu then select the type of twisting for the balls. 

X Axis / Y Axis

Select an axis for the twist effect. X-Axis twists the balls along the horizontal axis; Y-Axis
twists the balls along the vertical axis. The center of the twist travels along the selected
axis, twisting the sphere as it goes.

Center-X / Center-Y

Twists the balls towards the center point of the selected axis, in a wringing pattern. The
sides of the sphere twist in opposite directions away from the center point.

Radius

Concentrates the greatest twisting effect in the center of the source image. The twisting
effect diminishes as it moves away from the center of the image.
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Property (top), and the Center-X (bottom).



Random

The balls in an axis-independent fashion. This creates a less uniform effect.

Red, Green, Blue

The twist is applied, in varying degrees, to the selected color channel (red, green, or blue).
The least intense areas of the selected color channel receive the most twist.

Brightness

Twist is based on the luminance (or brightness) of the source image–the darkest portion
of the source image receives the most twist.

Diamond

The source image is twisted into a diamond-like shape.

Rectangle

The source image is twisted into rectangular shapes.

Fast Top

Twists along both the X and Y axes, with the Y axis twisting faster than the X axis.
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Ball Size

Press and drag the Ball Size control slider to set the size of your balls at any point along
the animation.  Dragging to the right increases your ball size, while dragging to the left
decreases it.
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FE BUBBLES
This plug-in creates the effect of bubbles floating up or down through your scene.
Bubbles are basically translucent balls, although they do have some additional unique
properties.

Reflection Type

Use this pop-up menu to select the reflection type for your bubbles.  

Inverse Reflection creates bubbles that reflect themselves. 

World Reflection creates bubbles that reflect the source image. 

Shading Type

Use the Shading Type pop-up menu to specify which type of shading (if any) to use for
your bubbles.  Bubbles with no shading type selected are uniformly shaded.

Lighten creates bubbles that are brighter at their periphery.

Darken creates bubbles that are darker at their periphery.

Fade Inward creates bubbles that become more transparent toward their center (like soap
bubbles).

Fade Outward creates bubbles that become more transparent toward their periphery.
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Bubble Tip

For a smoky effect, try using Fade Outward with a
very high number of bubbles.

The FE Bubbles dialog box.



Bubble Amount

Set the number of bubbles for your effect with this slider. Dragging to the right creates
more bubbles, dragging to the left creates fewer bubbles.

Bubble Speed

This slider controls both the speed of the bubbles and their rise or descent. The center of
the slider is idle, moving to the right increases the speed of the bubbles and causes them
to rise. Moving to the left slows down the bubbles and causes them to descend.

Amplitude

As each Bubble rises or falls, it oscillates slowly from side-to-side. The Amplitude sets the
distance the bubbles move from side-to-side as they rise or fall. Dragging to the right
increases this distance, dragging to the left decreases it.

Frequency

The Frequency slider determines how rapidly the bubbles move in this side-to-side motion.
Dragging to the right increases this speed, causing a more turbulent, less uniform rise,
while dragging to the left slows down the side-to-side motion. (See “Amplitude,” above.)

Bubble Size

All bubbles are not created equal–in size.  However, they are all within a general size
range. Use this slider to specify the overall size of your bubbles.  Drag to the right for larger
bubbles, or to the left for smaller ones.
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FE COLOR OFFSET
This effect enables you to offset the value of each color channel.  The starting point for
this rotation is always the original value for each color channel.

Red, Green, and Blue

Three control dials let you specify the amount of offset for each individual color channel.
As you rotate each control dial, the corresponding color in your source image is adjusted
according to the amount set with the dial.

For example, in every pixel in a 24-bit image, you have eight bits of information for each
color (Red, Green, and Blue). An 8-bit number can hold 256 values, with a range of 0-
255. As you rotate each control dial, the value of that color is rotated through the range of
0-255, starting at the original value of the color. 

So what happens when you hit 255 then continue rotating out of the color’s limits? This is
determined by the Overflow Behavior (see below) you select.

Overflow Behavior

Press on the Overflow Behavior pop-up menu to select how the Color Offset effect deals
with color values that “overflow” their legal limits.

Wrap

Colors that become too bright (or intense) are wrapped around to darker values. It takes
two full cycles to return to the original color. 
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Solarize

The Solarize option reflects color overflow back to the lower values, creating a duller, cool-
er, more surrealistic look.  

Polarize 

Polarize increases color vibrancy, accentuating the warmer values and enhancing details.
This reflection is smoother than that created with the Solarize option.

39Final Effects AP Explorer’s Guide

FE
Color O

ffset



FE FLO MOTION
Flo Motion produces a vortex distortion, something like a black hole pulling in or ejecting
an object. Flo Motion is especially useful for producing flowing effects in backgrounds, but
it can also be applied to foreground objects. You can create either a single vortex effect or
two vortex effects.

Knots 1 & 2

The knots specify where the distortion begins. They are like vortices that pull the source
image in or push it out. One or both knots can be active at any time.

To make the knot active, move the slider past zero (or enter a value greater than 0). A 0
value means the knot is inactive and produces no distortion. Moving the slider to the right
causes the source image to be “sucked into” the vortex. The further right (or the higher
the numeric value), the more exaggerated the effect. Moving the slider to the left of the
center causes the source image to be “pushed out” of the vortex.

Fine Control

Fine Controls increases the sensitivity of the Knots sliders by a factor of twenty and gives
you more subtle Flo Motion effects. Fine Controls decreases the amount of distortion you
can inflict with the Knots sliders! A setting of 1.00 with Fine Controls turned on is equiva-
lent to a setting of .05 with Fine Controls turned off. This is a global control for both
knots–you can’t have one knot with regular control and one with fine control.
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The FE Flo Motion dialog box.

Pausing a Vortex

To create a pause in your vortex distortion, create a
keyframe with a zero value for the knot.



Wrap Edges

This feature produces seamless, symmetrical tiling. It fills the screen with tiles of the Flo
Motion image rather than have the distortion pull away to reveal the background. To get
more tiles, choose higher numerical settings for the Knots (see above.)

Falloff

Use Falloff to fine tune the intensity of the effect without changing any of the other set-
tings. As you lower the Falloff value (by moving the slider to the left), the Flo Motion effect
gets more pronounced. As you raise the Falloff value (by moving the slider to the right),
the Flo Motion effect becomes less pronounced. When you move the slider all the way to
the right, the Flo Motion effect is effectively removed. Falloff affects both knots simultane-
ously.
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FE KALEIDA
The Kaleida plug-in can be used to create cool, kaleidoscopic effects.

Set Center

To set the center of the Kaleida effect, click the mouse in the preview window to set the
sample area to be rotated in the center of the preview window.

Size

You can create different effects by varying the size of the kaleidoscopic tiles. Larger tiles
(move to the right) result in simpler effects with more recognizable image sections, while
smaller tiles (move to the left) result in complex kaleidoscopic effects with very little of the
original image recognizable within the effect.

Kaleida Type

Press on this pop-up menu to choose from among nine different types of kaleidoscopic
effects or “flavors.” 

Rotation

The Rotation control slider lets you set the angle of your image tiles within the effect.

42 Final Effects AP Explorer’s Guide

FE
K

al
ei

d
a

The FE Kaleida dialog box.



Floating Center

The Floating Center is the area of your image that is equivalent to the target of a kaleido-
scope. Click this option, then click in the Preview window to select the Floating Center.
Moving the centerpoint to a different area in the preview window will then sample and
rotate the image from around that point.
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FE LENS
This effect can be used to create a lens distortion effect for your source image.

Position

Sets the center of the Lens effect.

Size

This slider lets you set the size of your lens in relation to your source image.  The size of
your lens determines the radius of the lens distortion effect.

Convergence

Use the Convergence slider to change the lens from convex to concave (or concave to
convex, we can never remember which is which). Drag the slider to the left for a more
concave effect (bowl-like), or to the right for a more convex (mound-like) effect.
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FE PARTICLE SYSTEMS II
This effect creates particle effects such as smoke, fire, explosions, and so on.  Before
describing all the particle controls, perhaps a little discussion about particles would be
helpful. Particles are born at a certain place (Producer Point), with a certain color (Birth
Color) and size (Birth Size). They travel at different speeds and in different directions
(Velocity, Direction), are affected by gravity over time, live a certain period (Longevity),
then die with a given color (Death Color, which can be different than Birth Color).

The key to understanding particles is to realize that you are creating lots of small objects
that each have attributes that determine how they behave and look. Many of these attrib-
utes, described below, can be affected by gravity, turbulence, and direction to create even
more effects.

Note: When you animate attributes, the change in the attribute affects only those particles
generated after that keyframe. Depending on the longevity, there will be particles in the
image that are not affected by these changes because they were “born” before the change
occurred.

Producer

This specifies the producer point of the particles. The producer point is the center of the
area where the particles are emitted from (the width and height of this area is determined
by X and Y Radius; see below). Click in the Preview window to define the producer point.
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Composite Particles

Composite particles directly over your clip by clicking on this button. If this option is not
selected, particles will be composited over a black background.

X-Radius and Y-Radius

Use these sliders to define the emitter area (specify an X and Y radius of the particle emit-
ter area). For example, if you want particles to spray out from a tiny hose, set a smaller X
and Y-radius. If you want your particles to spray out from a huge fire hose, use larger X
and Y-radius values.

Direction

This slider controls the direction the particles are emitted. Rotate the control dial to select a
direction. Try adjusting the direction for different particle animation types to see the various
effects you can achieve.

Velocity

Velocity is the speed at which the particles travel. The more you move the slider to the
right, the faster the particles travel. This is not the same thing as acceleration–which is the
rate of change in particle speed. Your particles maintain a steady velocity (speed) with NO
acceleration.
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The original image (top), and after use of the FE
Particle Systems II plug-in.



Birth Rate

This slider controls the amount of particles that are emitted (the emission rate). The higher
the Birth rate, the more particles are emitted into your scene.

Longevity

This slider sets how long each particle lives. The further you move the slider to the right,
the longer the particles live. As in real life, you’re better off not trying to alter the aging
process. That is, you can’t animate this parameter with expected results. 

Gravity

Particles are affected by gravity over time. Use this slider to control how the particles are
affected by gravity. Note that negative gravity values mean “reverse gravity” so your parti-
cles travel upward rather than being pulled down (because, after all, that’s what gravity
does, right?) Hint: To create effects like fire and smoke where you want your particles to
rise, but not rapidly, try using a near zero gravity value.

Turbulence

Turbulence introduces disturbances in the particles’ motion path, creating more erratic, less
uniform motion. 

Particle Animation

The preceding controls define general particle attributes–creation properties and general
behavior. Particle Animation lets you choose the type of motion (or animation) for your
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particles. Each animation type defines how the particles move through your scene once
they are born. Many of these types can be further affected/adjusted with Gravity, Velocity,
Turbulence, and Direction.

Explosive 

Particles radiate from the center, and spread evenly in all directions at random speeds. This
effect is useful for creating fireworks, which you can simulate by alternating the Birth Rate
between zero and a high value.

Fractal Explosive

Particles are spread in a pattern according to a fractal model.  Alter the model using the
Direction control dial to change the fractal model. This effect is useful for creating an
uneven look, for example a natural explosion. 

Note: Fractals are not interpolated. This means there are sharp transitions if you animate
Direction. 

Viscous Explosive

This is just like Explosive (see above) where the particles radiate evenly in all directions,
however, they meet with resistance. Use Turbulence to adjust the amount of resistance.
Increase the Turbulence to slow the particles down–remember, you’re introducing distur-
bance to their motion path. This is useful for creating realistic fireworks whose particles
appear to meet air resistance.
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Twirl

The Twirl effect looks somewhat like a pinwheel. The twirling motion goes in one direction,
and the particles radiate evenly from the center of the twirl. The direction of the twirl is set
by the Direction control dial. Turbulence controls rotation acceleration.

Twirly

Creates a Twirl that has a more random rotation. That is, the particles radiate with a less
defined spiral pattern–but not in completely straight rays, as with Explosive. The direction
of the twirl is controlled by the Direction control dial. Turbulence controls rotation speed. 

Vortex

Creates a whirling, funnel-like effect. The particles rotate upward. Gravity controls the width
of the vortex; increasing gravity increases the width of the vortex at the base because there
is a stronger pull on the particles so more of them are pulled downward. Use the Direction
control dial to control the rotation speed and the Turbulence slider to control rotation
acceleration. Remember, increasing Turbulence increases resistance which slows things
down!!!

Fire

The fire effect particles emanate from the center and bloom outward, oscillating as they
rise, pretty much like, well, a fire. Increase the Turbulence to increase the distance the par-
ticles move side-to-side.

Note: Since fire naturally burns upward, use a positive Gravity value so your particles rise.
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Direction

Particles spread evenly in the direction set in the Direction control. Turbulence defines the
area covered by the effect–the higher the Turbulence, the larger the area.

Direction Normalized

Particles spread evenly in the direction set in the Direction control. All particles have the
same speed (mathematically speaking this is because the magnitude has been normalized
to 1). Turbulence defines the area covered by the effect–the higher the Turbulence, the
larger the area.

Bi-Directional

Particles spread evenly in opposite directions, based on the direction set with the Direction
control dial. Turbulence defines the area covered by the effect–the higher the Turbulence,
the larger the area.

Bi-Directional Normalized

Particles spread evenly in opposite directions, based on the direction set with the Direction
control dial.  All particles have the same speed (mathematically speaking this is because
the magnitude has been normalized to 1). Turbulence defines the area covered by the
effect–the higher the Turbulence, the larger the area.

Particle Objects

Particle Animation was where you defined the particle behavior, Particle Objects lets you
define the particle appearance, by choosing the types of objects you emit as particles. You
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can choose from various 3D, Lens, Pixel, Spherical, and Textured objects. Experiment with
each object type to see what they look like with each animation type.

Pixel

Each particle is a single pixel. In motion, the pixel particles appear as lines because of their
steady motion path and longevity.

Antialiased Pixel

Similar to the pixel particles, but these particles are antialiased (smooth) lines.

Star

Creates four-pointed star particles. These particles are great for creating glitter effects.

Drop

Creates particles shaped to simulate drops of water, shaded with the Birth and Death col-
ors. Note: To create “rain” effects use the FE Rain plug-in.

Shaded Sphere

The particles are shaped like spheres that are darkened at the edges.

Faded Sphere

The particles are shaped like spheres, but with faded edges this time.
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Shaded & Faded Sphere

The particles are shaped like spheres, that are, surprise, both darkened and faded at their
edges.

Bubble

The particles are bubbles–spheres that are faded toward their centers. To create bubbles
with greater control over the bubble appearance, use the FE Bubbles plug-in. 

Motion Polygon

Creates particles shaped like non-square polygons. Increase the size of the polygons by
increasing the speed.

3D Polygon

Particles are shaped like 3D polygons, shaded as if the light source were the viewer’s eye.
Rotation speed can be controlled by the Direction control dial.

3D Squares

Particles are shaped like 3D squares, shaded as if the light source were the viewer’s eye.
3D squares are not actually three-dimensional. Rather they create a visual effect of being
3D through their motion. Use the Direction control dial to adjust the rotation speed.
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Cuby

Ok, these are 3D “squares.” These cube-shaped particles are shaded as if the light source
were the viewer’s eye. Rotation speed is set with the Direction control dial.

TetraHedrons

Particles are shaped like tetrahedrons, shaded as if the light source were the viewer’s eye.
Rotation speed is set with the Direction control dial.

FE

Particles are shaped like the letters FE and shaded as if the light source were the viewer’s
eye. Rotation speed is set with the Direction control dial.

Textured Poly

Particles are triangle-shaped and are texture mapped using the underlying image as the
texture map. They are lit as if the light source were the camera’s lens. Rotation speed is
set with the Direction control dial.

Textured Square

Particles are texture mapped squares where the underlying image is used as the texture
map. They are lit as if the light source were the camera’s lens. Rotation speed is set with
the Direction control dial.
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Lens Convex

Each particle is a convex (mound-shaped) lens object that modifies the source image as
the particle passes over it.

Lens Concave

Each particle is a concave (bowl-shaped) lens object that modifies the source image as
the particle passes over it.

Lens Fade

Again, each particle is a lens object, but each lens fades toward the edges.

Lens Darken Fade

Guess what, each particle is a lens again, but this time each lens darkens and fades
toward the edges. This is a great particle type for creating a dark, billowy smoke effect.

Lens Bubble

Each particle is a Bubble. (This is similar to FE Bubble, but here you have all the particle
controls that are not available in FE Bubble, such as Gravity, Turbulence, Direction, Velocity,
Birth and Death attributes, and so on.)

Birth Size and Death Size

Use these controls to specify the size of particles at the time they are born and die. Final
Effects AP automatically interpolates between the sizes over the lifespan of the particles.
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Opacity Map

This specifies how the particle’s opacity changes over time. These options, listed below, are
calculated taking the particle longevity into effect. Therefore, you will never have a fade
out, for example, that takes longer than the particle’s life.

Fade Out 

The particles disappear over time. The time it takes to fade is automatically set based on
the Longevity value.

Fade In 

The particles appear over time. The time it takes to appear is automatically set based on
the Longevity value.

Fade In and Out

The particles appear and then disappear once within the lifespan (Longevity) of the parti-
cles.

Fade Out and In

The particles disappear and then appear once within the lifespan (Longevity) of the parti-
cles.

Oscillate

The particles appear and disappear in cycles throughout the lifespan of the particle.
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Fade Out Fast

The particles fade out fast.

Constant

The particles have a constant opacity; i.e., the opacity stays the same over the lifespan of
the particle. 

Max Opacity

Set the maximum opacity for all particles. For example, if you want to limit the particles
from becoming fully opaque, you can set a maximum opacity such that the particles
approach total opacity but never achieve it. 

Color Map

Here’s where you specify the color assignment for your particles. Colors can be deter-
mined by the explicitly defined Birth and Death colors or from the source image. You have
four ways to specify the color of the particles. (See “Lifespan Colors” for information on
selecting the Birth and Death colors.)

Original Death

Particles use the source image to specify their Birth Color; the Death Color is determined
by the explicitly defined Death Color in the Lifespan Colors.

56 Final Effects AP Explorer’s Guide

FE
Pa

rt
ic

le
 S

ys
te

m
s 

II



Birth Original

Particles use the explicitly defined Birth Color from the Lifespan Colors and the source
image to define the Death Color.

Original Original

The Birth and Death colors of the particles are determined by the source image; the
Lifespan Colors are completely ignored.

Lifespan Colors

Select the Birth and Death colors to be used by the Color Map selection. 
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FE PIXEL POLLY
This plug-in shatters your source image into pieces, as if it were a glass window hit by a
baseball. You have complete control over the shattering force, as well as the appearance
and behavior of the shattered pieces as they fly through the “virtual air.” 

Explosion Center

This sets the center of the shattering. Continuing with the baseball/window example, this
would be where the ball hits the window.

Number of Polygons

Select the number of pieces (polygons) your image is broken up into. The higher the
number, the more pieces your clip is shattered into. 

Explosion Speed

This sets the speed at which the polygons travel when they are shattered. To create a vac-
uum effect (as if the particles are being pulled away from the explosion center), increase
the Explosion Speed over time.

Gravity

You can control the motion path of the shattered pieces by adjusting the amount that
Gravity that affects them. For example, a high gravity pulls the shattered pieces toward the
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bottom of the image very quickly. Now try a negative gravity (by moving the slider to the
left side) and see what happens.

Rotation Speed

As each polygon flies through the air, it spins around its own center. Use Rotation Speed to
set how fast the polygons spin around their own center. 

Direction Randomness

This adds randomness to the direction that each polygon travels. Instead of traveling in a
relatively straight line from the center of the explosion, each polygon moves in a less uni-
form path.

Speed Randomness

This adds randomness to the speed at which each polygon travels, creating less uniform
motion.

Polygon Shape

Select the shape of the shattered pieces from four options. 

Polygon

Each piece is a solid-colored, non-square polygon. The solid color is determined by the
color of the source image that you are shattering.
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Textured Polygon

Each piece is a non-square polygon that is texture mapped using the underlying image as
the texture map. (Texture mapping takes an image and maps, or applies, it onto a poly-
gon.)

Square

Each piece is a solid-colored square. The solid color is determined by the color of the
source image that you are shattering.

Textured Square

Each piece is a texture-mapped square that uses the source image as the texture map.
(Texture mapping takes an image and maps, or applies, it onto a polygon.)
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FE RAIN
This plug-in can be used to create synthetic rain, falling onto your clip. You can control the
appearance and behavior of the rain.

Drop Size

Use this slider to set the size range of your raindrops.  Dragging to the right increases the
maximum size of your drops, while dragging to the left decreases the maximum possible
size.

Rain Amount

This slider determines whether you are caught in a torrential downpour (drag to the right)
or just a light shower (drag to the left) by specifying the number of raindrops.

Rain Speed

This slider also determines the type of shower by adjusting the speed of the downpour.
Move the slider to the right to create a monster winter storm, move it to the left to create
a gentle summer sprinkle.

Rain Angle

A true storm will blow those raindrops in at an angle. Create this effect by adjusting this
slider to set the angle at which the raindrops fall.
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Opacity

The harder it rains, the harder it is to see through that “wall of water,” right? Drag this slider
to the right to increase the rain opacity, making it harder to see through.  Drag it to the left
to decrease rain opacity and regain your visibility.

62 Final Effects AP Explorer’s Guide

FE
R

ai
n

The original image (top), and after use of the FE
Rain plug-in.



FE SNOW
Similar in principle to the FE Rain plug-in, FE Snow creates snow-like particles on your
image.  Change the amplitude and frequency of your snowfall to create flurry-like effects.

Flake Size

Do you want big, fluffy flakes? Drag this slider to the right to create larger snowflakes or to
the left for smaller, ice-crystal flakes.

Opacity

Drag this slider to the right to increase the opacity of your snowflakes, making those large
fluffy flakes more fluffy.  Drag to the left for icier,. more transparent flakes.

Snow Amount

Is this the first snowfall of the season or a heavy-duty, mid-winter storm? Set the amount
of flakeage with this slider, dragging to the right to create a “school’s closed, snow-day”
effect, and to the left to create minimal coverage.

Snow Speed

To create snow flurries, drag this slider to the right to increase the speed of snowfall.  Drag
to the left to decrease this speed and create gentle a gentle snowfall.
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Amplitude

As snowflakes fall, they gently move from side-to-side. The Amplitude slider controls the
amount of this side-to-side motion of the snowflakes.  Dragging to the right increases this
distance, mimicking the movement of large, slow-moving flakes. Dragging to the left
decreases this distance, so your flakes fall more like a snow flurry.

Frequency

Use the Frequency slider to adjust the speed of the side-to-side motion as your flakes
descend. Move to the right to increase the speed, and to the left to decrease it.
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FE SPHERE
This effect takes your source image and texture maps it onto a 3D sphere. You can control
the effect by adjusting the lighting and rotation. This effect is really great when you need to
do spheres quickly, as you can do it all within Premiere without having to use a dedicated
3D program.

Light Source

Sets the position of the light source that illuminates the sphere.

Radius

Controls the size of the sphere by setting the radius.

Rotation (X, Y, Z axis)

Rotate your sphere on any or all three axes (X,Y, Z) using these control dials. 

Ambient

Set the brightness of the ambient part of the sphere. The ambient part of the sphere is the
part which is not directly illuminated by the Light Source (i.e., the part of the sphere in
shadow, like the dark side of the moon). 
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Diffuse

Set the brightness of the area of the sphere directly illuminated by the Light Source. (This
area is the opposite of the Ambient area.)

Specular

Control the shininess of the sphere with this slider. The higher the setting, the shinier or
glossier the sphere appears. As you increase the Specular value, you start to see a
Specular Highlight appear–because shiny surfaces reflect more light. The Specular Highlight
is the very shiny highlight you see in the center of the diffuse area as you increase the
Specular value. (Control the size of the highlight by adjusting the Roughness, see below.)

Roughness

Surface roughness determines how the light is reflected. The higher the Roughness, the
more unevenly light is reflected. This creates a larger the Specular Highlight because the
surface roughness causes the highlight to “spread.”
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FE STARBURST
This plug-in creates a star field based on the colors of the source image and creates the
illusion that the viewer is flying through this star field.

Speed

The Speed slider determines the speed at which the starts travel toward you. Dragging this
slider to the right to increases this speed and creates the illusion that you are traveling for-
ward into space. Now drag the slider past the midpoint and to the left and the stars
change direction, moving away from you. This gives the illusion of moving backwards.

Number of Stars

One of many self-explanatory controls in Final Effects AP, this slider is used to increase
(drag to the right) or decrease (drag to the left) the number of stars in the “sky.”

Size

Drag this slider to the right for bigger stars, or to the left for smaller ones.

Color

To set the color of FE Startburst’s stars, simply select the Use Color check box and access
the color picker for the desired color.
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TRANSITIONS
Final Effects AP includes four transitions, for “transitioning” between clips. They appear  in
the Transitions Window, with the other Premiere transitions and work similarly to those
them. Simply drag a transition to the overlapping portion of the two clips you’re transition-
ing between, select the direction of the transition, and you’re done. For more info on tran-
sitions in general, consult your Premiere manual.

FE Page Turn

A transition that simulates a page turning. This transition is the same as that provided by
the FE Page Turn filter, but it does not provide the level of control that the FE Page Turn fil-
ter does.  

FE Radial ScaleWipe

This transition “wipes” the layer from the center outward, adding a bulge at the edge of
the transition.

FE ScaleWipe

This transition stretches the layer on or off of the screen.

FE Twister

This transition “twists” one layer into another. 
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GLOSSARY
birth.  The state of a particle upon creation.  Included in a particle’s birth information is
location, size, shape, color, etc.

composite.  A layer composed of two (or more) images.  To combine two or more
images onto a single layer.

death.  The state of a particle upon destruction.  See “birth.”

floor.  The baseline for the effects created by many of the Final Effects plug-ins, such as
Slant or Slant Matte.

fractal.  A mathematical model used to describe infinite, repeating divisions of a finite sur-
face.

gravity.  A measure of particle weight in a particle system.

knot.  In FE Flo Motion, the point around which the distortion is anchored.

longevity.  A measure of the duration (or lifespan) of particles in a particle system.

particle system.  A definition of the movement of a set of particles over a period of time.

producer.  In a particle system, the point from which all particles emanate.

rotation axis.  An axis (either the horizontal-X, vertical-Y, or depth-Z) around which vari-
ous particle (or other) effects take place

scatter.  An effect in which the particles comprising an image move steadily away from
one another and from a center point.
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turbulence.  A measure of the degree of random motion of particles in a particle system.
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SOFTWARE LICENSE AGREEMENT
You should carefully read the following terms and conditions before opening this package.  By opening the package
you are agreeing and indicating your acceptance of these terms and conditions.  If you do not agree with them you
should return the package unopened to the dealer from whom you purchased and your money will be refunded.  If
the dealer from whom you purchased this package fails to refund your money, contact MetaTools, Inc. immediately at
the address below.

MetaTools, Inc. (hereinafter referred to as Company), a California based Corporation, provides the computer software
(hereinafter referred to as Program)  contained on the medium in this package and licenses its use.  You assume full
responsibility for the selection of the Program to achieve your intended results and for the installation, use and results
obtained from the Program.

License

A. In consideration of the payment of a license fee, you are granted a personal, non-transferable and non-exclusive
license to use the Program under the terms stated in the Agreement.  You own the diskette or other physical
media on which the Program is provided under the terms of this Agreement, but all title and ownership of the
Program and enclosed related documentation (hereinafter referred to as Documentation), and all other rights not
expressly granted to you under this Agreement, remain with the Company.

B. The Program may be used by you only on a single computer.  Therefore, you must treat this software just like a
book.  With the exception of Item D below, just like a book means that this software may be used by any num-
ber of people and may be freely moved from one computer location to another, so long as there is no possibili-
ty of it being used at one location while the same copy is at the same time being used at another location.  Just
as the same copy of a book cannot be read by two different people in two different places at the same time, nei-
ther can the same copy of software be used by two different people in two different places at the same time.  Site
licenses for multiple single users are available.  Contact MetaTools, Inc. for details.

C. You and your employees and agents are required to protect the confidentiality of the Program.  You may not dis-
tribute or otherwise make the Program or Documentation available to any third party.

D. You may not copy or reproduce the Program or Documentation for any purpose except to make one (1) archival
copy of the Program, in machine readable or printed form for back up purposes only in support of your use of
the Program on a single computer.  You must reproduce and include the Company copyright notice on the back-
up copy of the Program.
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E. Any portion of the Program merged into or used in conjunction with another program will continue to be the prop-
erty of the Company and subject to the terms and condition of this Agreement.  You must reproduce and include
Company’s copyright notice on any portion merged in or used in conjunction with another program.

F. You may not sublease, assign or otherwise transfer the Program or this license to any other person without the
prior written consent of Company.

G. You acknowledge that you are receiving on a LIMITED LICENSE TO USE the Program and Documentation and that
the Company retains title to the Program and Documentation.  You acknowledge that Company has a valuable
proprietary interest in the Program and Documentation.  You may not use, copy, modify or transfer the Program
or Documentation or any copy, modification or merged portion in whole or in part except as expressly provided
for in this Agreement.  If you transfer possession of any copy modification or merged portion of the Program or
Documentation to another party, your license is automatically terminated.

H. If you have purchased a NETWORK version of the software, this license agreement applies to the installation of
the software onto a single file server.  It may not be copied onto multiple systems.  Each node connected to the
file server must also have its own node copy of the software that becomes a license for that specific user.

Term

This license granted to you is effective until terminated.  You may terminate it at any time by returning the Program
and Documentation to Company together with all copies, modifications and merged portions in any form.  The license
will also terminate upon conditions set forth elsewhere in the Agreement, or if you fail to comply with any term or con-
dition of this Agreement.  You agree upon such termination to return the Program and Documentation to Company
together with all copies, modifications and merged portion in any form.  Upon termination, Company can also enforce
any rights provided by law.  The provision of this Agreement which protects the proprietary rights of Company will con-
tinue in force after termination.  Termination of this license either voluntary or involuntary does not entitle you to a
refund of your purchase cost except as provided elsewhere in this License Agreement.

Limited Warranty

Company warrants, as the sole warranty, that the medium on which the Program is furnished will be free from defects
in materials and workmanship under normal use and conditions for a period of ninety (90) days from the date of deliv-
ery to you as evidenced by a copy of your receipt.  No distributor, dealer or any other entity or person is authorized to
expand or alter either this warranty or this Agreement.  Any such representations will not bind the Company.  Company
does not warrant that the functions contained in the Program will meet your requirements or that the operation of the
Program will be uninterrupted or error-free.  Except as stated above in this section, the Program and Documentation
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are provided as-is without warranty of any kind either expressed or implied, including but not limited to the implied
warranties of merchantability and fitness for a particular purpose.  You assume entire risk as it applies to the quality and
performance of the Program and Documentation.  Should the Program prove defective you (and not Company, autho-
rized Company Distributor or dealer) assume the entire cost of all necessary servicing repair or correction.  This war-
ranty gives you specific legal rights and you may also have other rights which vary from state to state.  Some states do
not allow the exclusion of implied warranties, so the above exclusion may not apply to you.

Limitation of Remedies

Company’s entire liability and remedy will be:

A. The replacement of any medium not meeting Company’s ‘Limited Warranty’ explained above and which is
returned to Company or an authorized Company distributor or dealer with a copy or your receipt; or

B. If Company is unable to deliver a replacement medium which conforms to the warranty provided under this
Agreement, you may terminate this Agreement by returning the Program and Documentation to Company, autho-
rized Company Distributor, or dealer from whom you obtained the Program and your license fee will be refund-
ed.

Product Returns

If you must ship the Program and Documentation to an authorized Company Distributor, dealer or to Company, you
must prepay shipping and either insure the Program and Documentation or assume all risk of loss or damage in tran-
sit.  To replace a defective medium during the ninety (90) day warranty period, if you are returning the medium to
Company, please send us your name and address, the defective medium and a  copy of your receipt at the address
provided below.  In no event will Company be liable to you for any damages direct, indirect, incidental or consequen-
tial, including damages for any lost profits, lost savings or other incidental or consequential damages arising out of the
use or inability to use such Program and Documentation, even if Company has been advised of the possibility of such
damages or for any claim by any other party.  Some states do not allow the limitation or exclusion of liability for inci-
dental or consequential damages so the above limitation or exclusion may not apply to you.  In no event will Company
liability for damages to you or any other person ever exceed the amount of the license fee paid by you to use the
Program regardless of the form of the claim.
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US Government Restricted Rights

The Program and Documentation are provided with restricted rights.  Use, duplication or disclosure by the US
Government is subject to restrictions as set forth in subdivision (b) (3) (ii) of the Rights in Technical Data and Computer
Software Clause at (252) 227-7013.  Contractor/Manufacturer is MetaTools, Inc., 6303 Carpinteria Avenue, Carpinteria,
CA 93013.

General

This Agreement is governed by the laws of the state of California (except federal law governs copyrights and register
trademark(s)).  If any provision of this Agreement is deemed invalid by any court having jurisdiction, that particular pro-
vision will be deemed deleted and will not affect the validity of any other provision of this Agreement.  Should you
have any questions concerning this Agreement, you may contact MetaTools, Inc. at the address below.

MetaTools, Inc.
6303 Carpinteria Ave.
Carpinteria CA 93013
(805) 566-6200 voice
(805) 566-6385 fax
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